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How To Navigate This Book

Each PDF format book has a Table of Contents. Each Chapter

Heading and important Sub-Heading within the TOC is linked to the

relevant page in the book. Just click on the heading of the section you

wish to go to, and you will be taken there.

At the bottom of each page there’s a box, which indicates the page

number of where you are in the book, as well as the total number of

pages within the book.

Click on the number shown and a small box will pop up. Type the

number of the page that you want to go to into the box, click ENTER

and you will be taken to that page.

Alternatively, you can type the page number you want to go to over

the number showing in the box on the bottom task-bar, then just click

ENTER and you’ll be taken to this page.

On the left of the box that shows the page number there’s a single

triangle and a double triangle… both point to the left side of the page.

Click on the single triangle and you’ll go back to the previous page in

the book. Click on the double triangle and you’ll go back to the first

numbered page in the book.

On the right of the box that shows the page number there is a single

triangle and a double triangle…both point to the right side of the page.
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Click on the single triangle and you’ll go to the next page in the book.

Click on the double triangle and you’ll go to the last numbered page.

At the right side of your screen, there’s a Scroll Bar. It has these

functions:

One Page Forward Scroll: This is a small triangle pointing right.

Click this to move forward one page at a time in the book.

One Line Backward Scroll: This is a small triangle pointing up.

Click this once to move up one line at a time. While doing this hold

your mouse button down with the pointer on the arrow and you will

scroll steadily back through the book.

One Line Forward Scroll: A small triangle pointing down. Click this

once and you move down one line. Hold your mouse button down

with the pointer on the Arrow and you will scroll steadily forward

through the book.

At the left side of your screen, there is a small vertical panel titled

Bookmarks. This is an additional way for you to find a particular

section in the book. A couple of clicks and you’re there.

If the Bookmarks section is not already showing on your screen, you

can go to Acrobat Reader’s View Menu and click on Bookmarks and

Page. The Bookmark section will open. Or you can move your mouse

pointer over the vertical line at the left side of your page.

How To Navigate This Book
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How To Navigate This Book

The mouse pointer will change shape. When it changes shape, press

and hold down your left mouse button, and drag to your right. This

opens the Bookmark area.

You use this method (in reverse) to close the Bookmark area so there’s

more screen space available to display the book. Or you can click on

Page Only in the View Menu.

You will see that the Bookmarks are arranged in a stepped fashion

similar to the Table of Contents in your book. One difference is that

each Bookmark shows actual text from the page you will go to if you

click on that entry.

Each main entry in the list of Bookmarks will show a small icon

(small picture)  resembling a page with a corner turned down. At the

left of most of these icons you will see a small box with either a “+”

or a “-” in it.

A “+” shows there are sub-headings under that Bookmark but they are

compressed, and out of sight.

Click on the “+” and it will change to a “-” as the sub-headings appear

under the main Bookmark. They also each show a small piece of

actual text from the page they link to.

You can click on the “-” to close that section of the Bookmark list

when you have finished with it.
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How To Navigate This Book

In earlier versions of Adobe’s Acrobat Reader, the box with a “+” in it

was represented by a small triangle pointing right. When you clicked

on it and the sub-headings appeared, the small triangle changed to one

that pointed downward. In the current version of Adobe Acrobat

Reader,  the triangle pointing down is a small box with a “-” in it.

There are several options under the View Menu that you can click on

to adjust the way your book is displayed on your screen. Set them to

whatever suits you.

You cannot damage your book file with any of the adjustments you

make in this Menu and you can change the display settings at any time

if the circumstances of your viewing change.  For instance, you can

Zoom In to increase the size of the text showing on your monitor

screen. You can also adjust the area of the screen which the page

covers using the Fit Width, Actual Size and Fit Visible options in the

View Menu.

Be brave.  Play with the Acrobat Reader settings until you find the

settings that suit you.  However, if you require further assistance with

using Acrobat Reader to view your new book you can:

(1) Use the Help Menu at the right end of the Acrobat Reader Menu at

the top of the screen. (2) Email the person from whom you bought the

book. Allow them a couple of days to reply to you.  (3) You can click

here

click

here to download the latest FREE version of the Adobe Acrobat

Reader.

http://www.adobe.com
http://www.adobe.com
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Legal Statement

The Women Working From Home graphics are the property of

eBookWholesaler.net. All other material in this book is copyright ©

by the author, Rozey Gean, and no part of the book may be

reproduced or re-used in any form whatsoever without prior written

permission of the copyright holders.

This book is supplied for information purposes only and, as

experienced in this subject matter as the Author is, the material herein

does not constitute professional business advice.

The reader is advised to consult with an appropriately qualified

business professional. Neither the Author, nor eBookWholesaler.net,

nor any book distributors accept any responsibility for business

decisions made by purchasers of this book.
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About The Author

Rozey Gean has been writing, Women Working From 
Home, a weekly business column, since 1999.  Her 
dynamic and entertaining style of writing has helped 
thousands of business owners boost their businesses into 
overdrive.�

On-line, she is the founder of Marketing-Seek.com, a 
web site that is dedicated to helping writers, publishers, 
and entrepreneurs, gain exposure and quality content.

Off-line, Rozey is the owner of a successful Commercial Printing and Graphic 
Design company. Success always has a model, and Rozey is a women who has 
“walked her talk” by becoming a successful entrepreneur, on-line as she has off-
line. �
�
Ms. Gean is the author of several highly successful "info-products" including:

	 Frugal and Fun
	 www.FrugalandFun.com�

	 How To Format Article Content
	 www.Marketing-Seek.com/articles/tutorial/index.shtml

Rozey lives in Warren, Michigan with her husband, Ricky. She enjoys writing,
golfing, and playing guitar.

To hire Rozey, please contact her through:

Rozey Gean�

Web:�
www.Marketing-Seek.com�
E-mail:
rozey@marketing-seek.com

Postal:
11259 Fisher Ave., Warren, MI 48089�
Phone:
(586) 754-6731

http://www.marketing-seek.com/index.shtml?wwfh_book
http://www.frugalandfun.com/index.shtml?wwfh_book
http://www.marketing-seek.com/articles/tutorial/index.shtml?wwfh_book
http://www.marketing-seek.com/index.shtml?wwfh_book
mailto:rozey@marketing-seek.com?subject=Contact&body=WWFH_Contact_Notice
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Women Working From Home

This book, written by a successful entrepreneur, is for women who wish to work

from home. Rozey Gean takes the reader step by step through the necessary

processes to work successfully from home.

These processes are universal, irrespective of whether the reader is male or female.

However, success always has a model.

The author, Rozey Gean is a woman who works from home herself. Rozey knows

the pitfalls, the joys and the rewards of doing this.

Rozey has constructed an excellent model to follow.



Women Working From Home

© Rozey Gean,  All Rights Reserved www.WomenWorking.net

- 11 -

Before You Begin Your Business

The reasons range from wanting to be at home with the children to desiring

creative independence. For whatever their unique reasons may be, women around

the world are trading in their business suits for a more leisure/work style in the

comfort of their own homes.

To become a successful work-at-home entrepreneur, you must possess more than a

desire to work from your own home. You must have certain characteristics that

seem to follow the most successful entrepreneurs. They include:

•  A high level of self-motivation and personal drive A commitment to

work long hours each day as you grow your business.

•  The ability to establish a plan with concrete goals and work hard to

achieve them.

•  A willingness to take risks.

•  Specific expertise, knowledge, and talent in your field of interest.

•  Ability to identify your market and reach them.

In addition, you must realize that you could work for months before actually

generating a profit.

If you possess the majority of these characteristics, then you have a shot at making

it on your own. Determining what business is right for you will require a short self-

assessment.

Do You Have What it Takes?

SEVEN things to consider before

you commence your business.
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Examine the type of skills and experience you possess that could be brought into

your business.

For example:

• If you are interested in starting a bookkeeping service, do you possess

good skills in math, working with calculators, and knowledge of how

a bookkeeping system works?

• What do you enjoy doing with your time? Are you a person who ini-

tiates or one who seems to procrastinate? Are you a “busy” natured

person or do you get pleasure out of sitting down with a good book or

watching television?

• Can you turn your hobbies and interests into cash? For instance, could

you easily market your woodcraft hobby and meet the demand it may

incur?

• Will your family, especially your spouse, support you in your business

endeavors? It is extremely important that your family supports your

decision to venture out into business. You will depend on their

strength, support, and encouragement each step of the way.

• How much of your time will have to be put into operating a business?

Expect to spend many hours each day managing and growing your

business, especially during those crucial months of getting started.

• What products and/or services can you offer? Make a list of what you

will sell, whether it is actual products or services.

• Who are your competitors and what advantages will you have over

them? Research and discover who else in your locality or via the

Internet is offering the same products and services? What can you do

to give you an edge over them?
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• Is your idea practical and will it fill a need? Will there be a demand

for what you have to offer? Is it something that will meet the needs of

your target audience?

• How much money do you need to get started and are you aware of any

resources to fund your business? Conduct research and cost compari-

sons on everything you will need. Factor in all costs that come to

mind in determining the amount of money you will need in order to

get the business up and running. How will you fund it?

• What equipment and supplies will you have to purchase to get started

and meet your future needs?  Make a list of everything you must have

to get started now, keeping growth in mind.

Following this self-assessment, you should have a good idea if working from your

home is right for you and if you have what it takes to make it work.

Working from home is not for everyone. Many individuals prefer the “benefits” of

working for someone else.

Once you determine whether or not you possess what it takes to venture out on

your own, then you will be ready to move forward and discover what business is

right for you.
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Discovering the Right Business for You

Discovering the right business for you is a personal issue that differs from one

individual to another.

Many home-based workers are able to bring existing skills and experience into

their own business that have been accumulated and cultivated while working

outside of the home.

For instance, a woman who has spent 20 years working as an executive assistant in

corporate America would more than likely succeed as an on-line virtual assistant or

as a home-based secretarial service.

Her vast experience would allow her to combine all of her skills and talents into a

complete package she could sell to other businesses around the world, or in her

own local marketplace.

Things to Avoid

While conducting your research to find the right business for you, there are pitfalls

you will need to avoid.

The major area you need to be wary of is “get-rich quick” schemes. Keep in mind

that success does not come overnight. Do not let anyone fool you with their sales

pitch about how they have made millions because they “told two people and those

two people told two more people” and so on and so on.

Additionally, you will not get rich stuffing envelopes, stringing beads, sewing baby

bibs, or assembling products. The small and enticing magazine advertisements that

introduce you to business opportunities are not always what they appear to be.

You must focus on your specific talents, skills, and experience to determine what

business will work for you. Then, you must work smart at becoming successful at

what it is that you do best.
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Research Before Taking the Plunge

Your local library, bookstore, and even the Internet provides access to numerous

resources that you can utilize in discovering home-based business opportunities

that you can build upon from a “grass roots” start up.

Many of these resources even provide details on what it takes to get started. The

following sites are two of many, which are dedicated to assist you in determining

what type of home-based business you are best suited for:

BizyMoms

http://www.bizymoms.com/ideas.html

Lewis Publishing

http://www.newworkplace.com/biz_ideas.html

If you are serious about starting your own home-based business, be serious about

doing your homework. Research is absolutely crucial in the initial phases. Not only

will you need to determine what business is right for you, but you will also need to

know what will be required of you to make it happen.

Find out what, if any, business license is needed in your particular area. Depending

upon where you live, you may be required to comply with specific zoning codes, as

well.

Contact your local Chamber of Commerce office for more details that may be

specific to your locality. Once you dispense with the legalities, take some time to

develop a business plan with goals that you can reach on a consistent basis.

For assistance in writing a business plan, visit The Small Business Administration:

http://www.sba.gov/starting/indexbusplans.html

During the financing phases of your business, it is very common for financial

institutions to request a business plan coupled with a loan application.

http://www.bizymoms.com/ideas.html
http://www.newworkplace.com/biz_ideas.html
http://www.sba.gov/starting/indexbusplans.html
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If you are certain you will need help in this area, seek a professional and

experienced writer to assist you.

Feel free to contact me personally for other references.

mailto:rozey@marketing-seek.com

Once you are up and running, the sky is the limit!

Take your business seriously, just as you would your job in someone else’s

company. Create a happy and healthy balance between work and home. Your

success will ultimately depend on you.

mailto:rozey@marketing-seek.com?subject=References&body=Enter.Question
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Establishing a Workspace to Call Your Own

Every entrepreneur needs a space to call her own . . . a place where the creative

juices can flow freely and interruptions can be kept to a minimum.

Whether your space consists of a transformed closet or an entire room within your

home, your work area should be a space to call your own. It really does not matter

that you do not have a separate room that you can designate for conducting

business.

Should you be able to only manage a corner in your dining room to set up your

computer workstation then so be it. That constitutes your workspace.

If, however, you are fortunate enough to have access to an entire room within your

home, then good for you! That is even better! No matter where your space is, stake

your claim! It is your territory and other family members should recognize and

respect your space, and make it a point to keep out.

Once you have established your space, then you have the fun-filled chore of setting

it up and organizing it to meet your needs. Again, keeping in mind the amount of

space you have available, carefully select the furniture and equipment that you

must have in order to meet your specific needs.

Arrangement of the furniture and equipment is a very important part of

organizing your office. Make sure you place each piece so that it is

ergonomically safe and within your reach for efficiently conducting

business.

As you begin to decorate your workspace surroundings, ask yourself if you will be

meeting with clients in this particular space. If so, create a professional and tasteful

decor, possibly one that reflects the type of work you do.

For example, if you are a photographer, fill the room with samples of your

photography work. A wedding consultant may choose to create a more romantic

look for her soon-to-be brides and grooms. It is always a good idea to include

among your relics any awards or certificates you have received for your work.
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